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           Office 2010 New Features: Overview             
 

 

OBJECTIVES 
Participants will be able to 

Examine enhanced interface components 

Identify tools in the Backstage View 

Locate Ribbon customization and printing options 

Explore new features in Word, Excel, PowerPoint, and Access 
 

 
 

FAMILIAR FEATURES FROM OFFICE 2007 
File formats including .docx, .xlsx, .pptx, and .accdb 

Interface look and feel, including the Ribbon, Quick Access Toolbar, Help icon, Status Bar, 

and main application workspace 

   Names of the Ribbon tabs, command groups, and locations of commonly used 

commands 

Icons used to represent commands in the Ribbon 

The ability to customize the Quick Access Toolbar 
 
 
 

OFFICE 2010 INTERFACE 
The Office 2010 user interface looks similar to the Office 2007 user interface, with some 

enhancements that may help increase user efficiency. 
 
 

Window Options 
 

The application icon, in the upper left corner of the window, contains commands to restore, 

minimize, maximize, and close the active window, much like the commands located in the 

upper right corner. 
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Backstage View 
 

The Backstage View, or File tab, replaces the Office Button, present in Office 2007 applications. 

Familiar commands, such as Save, Save As, Open, and Close, are located near the top of the tab. 

Icons to view and edit application Options and to Exit the application are located at the bottom 

of the list. Command categories, including a Recent files list and Help, are located in the middle 

of the tab. The Info category includes several familiar features, once found in a variety of places, 

now in one location. There are enhancements to some features such as New, Print, and Save & 

Send. The following provides more detail on several categories found in the Backstage View. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Info 

The Info portion of the Backstage View contains information about permissions, versions, and 

properties of the file. The name of the file is listed at the top of the window, and a detailed list of 

the file properties is provided along the right. In Access 2010, a link to the database properties 

dialog box is available in this area. 
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New 

The New category contains options for creating a new file. The options vary depending on the 

application being used. All applications provide tools to create a new blank file or one from an 

Office.com template. An icon is provided with each named option for creating a new file. 

 
Print 

Printing options have been reconfigured in Office 2010. Printing options are shown on the left 

side, and a print preview is provided on the right. This is the only location for viewing a print 

preview. The page/slide navigation for the preview is along the bottom of the window, and a 

Zoom to Page control is located in the lower right. In Word and PowerPoint, a Zoom Slider is 

found in the lower right as well. Excel has a Show Margins option to allow for a visual when 

resizing worksheet margins. The Print button in the upper portion of the window replaces the 

OK button to confirm the print job. The Print and Print Preview options in Access are different 

and are similar to the Access 2007 Print options. 
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Save & Send 

Options for sending files via e-mail, publishing them to the Web using Windows Live, and 

saving to a SharePoint site are located here. The Change File Type option lists a variety of file 

types. Starting the file saving process in this way is an alternative to going directly to the 

traditional Save As dialog box; yet, clicking the Save As button located here launches the Save As 

dialog box as well. This category is called Save & Publish in Access 2010. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Help 

The Help feature located in the Backstage View provides links to Microsoft Office online tools, 

along with tools to access application Options and Check for Updates. Application Help may also 

be accessed using the blue circle with the white question mark in the upper right corner of the 

interface. 
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Ribbon 
 

The Ribbon is arranged in tabs. Each tab houses categorized groups of application-specific 

commands. Each application has a certain number of default tabs and may show contextual tabs 

with additional tools when certain elements in the file are active. In Office 2010, the Ribbon can 

be minimized, as well as customized. 
 
 
 
 
 
 
 
 

Minimizing the Ribbon 

There are three ways to minimize the Ribbon and show only the tab names. The first two 

methods described below were available in the previous version, and the third option is new to 

Office 2010. 

   Right-click method: 

1.   Right-click a Ribbon tab. A short-cut menu appears. 

2.   Select Minimize the Ribbon. A check mark will be placed by this option to 

indicate it was selected. 

3.   Repeat steps 1 & 2 to maximize the Ribbon. 

   Double-click method: 

1.   Double-click a Ribbon tab. 

2.   Repeat step 1 to maximize the Ribbon. 

   Minimize the Ribbon button method: 

1.   Click the Minimize the Ribbon button (upward pointing chevron) in the upper 

right corner of the window next to the blue Help circle. The chevron will toggle to 

point downward. 

2.   Click the Minimize the Ribbon button (downward pointing chevron) in the 

upper right corner of the window to maximize the Ribbon. 
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Customizing the Ribbon 

Custom tabs and groups can be added to the Ribbon, commands can be added to custom groups, 

and the names of existing tabs and groups can be changed. The tools to perform these processes 

are found in the Customize Ribbon category in the application Options dialog box. The application 

Options dialog box can be accessed directly from the Options command in the Backstage View/File 

tab list, in the Backstage list’s Help category under Tools for Working with Office, or by right-clicking 

a Ribbon tab and selecting Customize the Ribbon… 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Add and name a custom Ribbon tab: 

1.   Within the application Options dialog box, click the New Tab button. 

2.   Select New Tab (Custom) in the list. 

3.   Click the Rename button. 

4.   Type the new name and click the OK button in the Rename dialog box. 

5.   Click the OK button for application Options dialog box. 
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Add and name a custom group on an existing Ribbon tab: 

1.   In the application Options dialog box, click the New Group button. 

2.   Select New Group (Custom) from the list. 

3.   Click the Rename button. 

4.   Type the new name and click the OK button in the Rename dialog box. 

5.   Click the OK button for application Options dialog box. 

   Add commands to custom groups: 

1.   Select a custom group name. 

2.   Select a command from the list on the left. 

3.   Click the Add>> button. 

4.   Click the OK button for application Options dialog box. 

 

NEW & ENHANCED FEATURES 
 

Features Available in Multiple Applications 
 

Paste Preview 

Paste Options include a variety of ways to paste text, either with or without formatting. The Paste 

Preview feature is used to preview the ways text can be pasted before it is actually pasted. Upon 

a right-click in the place where the text is to be pasted, a short-cut menu displays the various 

Paste Option buttons for the application. A preview of the text with each option is displayed 

when hovering over the options. When an option is selected with a click, the text is pasted 

accordingly. This feature is available in Word, PowerPoint, and Excel after a piece of text is 

copied and ready to be pasted. 
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Screenshot Feature 

The Screenshot feature is located on the Insert tab in Word, PowerPoint, and Excel. This feature 

captures screenshots from all open applications and allows them to be selected and pasted into 

the active file. The Screen Clipping command allows the screenshot to be cropped as needed 

before being pasted in the active file. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Artistic Effects 

The Artistic Effects feature is available on the Picture Tools contextual tab when an image is 

added to a file in PowerPoint, Word, and Excel. This feature can be used to add a variety of 

effects, such as Light Screen and Paint Strokes to an image. Live Preview is associated with this 

tool. 
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Word 2010 
 

Navigation Pane 

The Navigation Pane is part of the Find feature in the Editing group of the Home tab. When the 

Find tool is used, the pane opens on the left side of the Word interface. A search term is entered 

in the search box, and the resulting text is highlighted in the document and appears in the pane 

within the context used in the document. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
PowerPoint 2010 

 

Slide Sections 

The Sections command is located in the Slides group of the Home tab. Sections can be added to a 

presentation to organize slides. The sections can be named and removed as needed. When 

sections have been added, they may be collapsed and expanded as needed. 
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Excel 2010 
 

Sparklines 

The Sparklines feature is found in the Sparklines group of the Insert tab. Sparklines are small 

charts in individual cells. They may be used to summarize data and show trends. There are 

three types of Sparklines: Line, Column, and Win/Loss. When the command is selected, a dialog 

box appears to collect the Data Range to be used and the Location Range where the mini charts 

will be placed. When a Sparkline is inserted into a worksheet, the Sparkline Tools Design 

contextual tab appears on the Ribbon to provide formatting options. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Access 2010 
 

Table Datasheet View Fields Tab 

The Fields tab, present under the Table Tools contextual tab, contains tools to create and format a 

table in Datasheet view. The More Fields command provides an expanded list of field templates, 

including Quick Start options used to insert individual and groups of fields based on commonly 

used field categories. A Calculated Field option inserts calculations into the table based on field 

data type. 



 

Technology Training Resources 
 

To look for more advanced sessions of today’s training topic, visit 

http://its.psu.edu/training/catalog/ 
 

To browse or register for future technology training, visit 

http://its.psu.edu/training/ 
 

To learn about Training On Demand (sessions upon request for groups of 5 or more), visit 

http://its.psu.edu/training/ondemand/ 
 

To browse or join in online discussions about technology topics at Penn State, visit 

http://technologytraining.psu.edu/ 
 

To join the Training News List and receive monthly e-mail notification of all upcoming 

technology training opportunities, send a blank e-mail to 

L-TRAINING-NEWS-SUBSCRIBE-REQUEST@LISTS.PSU.EDU 
 

To find free online books on a variety of popular technology topics, visit 

http://proquest.safaribooksonline.com/ 
 

To explore hundreds of free video tutorials that are available for self-paced learning, visit 

http://its.psu.edu/training/lynda/ 
 

Follow us on Twitter at http://twitter.com/psuITStraining/ 
 

Become a Facebook fan of ITS Technology Training at 

http://www.facebook.com/psuitstraining/ 
 

 

Additional Technology Resources 
 

To contact the ITS Help Desk with general technology-related questions, e-mail 

helpdesk@psu.edu or call 814-865-4357 (HELP) 
 

To search for technology-related information in the ITS Knowledge Base, visit 

http://kb.its.psu.edu/ 
 

To purchase discounted hardware and software at Penn State’s Computer Store, visit 

http://computerstore.psu.edu/ 
 

 
 
 
 
 
 

Technology Training Provided by ITS Training Services 

23 Willard Building • University Park,  PA 16802 

Phone: (814) 863-9522 • Fax: (814) 865-3556 • itstraining@psu.edu 
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